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About the documentation
This User's Guide is divided into four parts:

• Getting Started - general information about TerraMatch and instructions on how to install 
and run the application.

• Tool Reference - detailed descriptions of all the tools in TerraMatch.
• Additional Information - information about the installation configuration.

Accessing the documentation online
The documentation is accessible as an Acrobat Reader PDF document which serves the role of 
online help. Accessing the electronic format of the documentation has the following advantages:

• You can conduct automated searches for keywords in topic names or body text.
• You can click hyperlinks to "jump" to related topics.

Document conventions
The following conventions and symbols appear in this guide:

• Data click - mouse click with the data mouse button, usually the left button on a right-hand 
mouse.

• Reset click - mouse click with the reset mouse button, usually the right button on a right-hand 
mouse.

• < > - angle brackets used for keyboard keys, for example, <Return>.
• Key in - input a command in the key-in line of MicroStation and then press <Return>.
• OR - alternate procedures or steps in a procedure.
• C:/TERRA - paths to directories of files on a hard disk are written with capital letters.
• Icons used to specify special information:

• When no distinction between MicroStation versions is necessary, this document refers to the 
CAD environment simply as "MicroStation".

• “Strip” refers to a flight line (ALS data) or a drive path (MLS data) if no explicit 
distinction is made.

MicroStation documentation
This document is written under the assumption that the reader knows how to use basic 
MicroStation features. You should refer to the printed documentation or on-line help of 
MicroStation whenever you need information about using the CAD environment.

Icon: Appears next to:
Notes and Hints
Procedures
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2 Introduction to TerraMatch

Introduction
TerraMatch fixes systematic orientation errors in airborne and mobile laser data. It measures the 
differences between laser surfaces from overlapping strips or differences between laser surfaces 
and known points. These observed differences are translated into correction values for the system 
orientation -- easting, northing, elevation, heading, roll and/or pitch.

TerraMatch can be used as a laser scanner calibration tool or as a tool for fixing actual project data. 
When used as a calibration tool, it solves the misalignment between the laser scanner and the 
inertial measurement unit (IMU). The end result is correction values for heading, roll and pitch 
which apply for the whole data set.

Actual project data may contain error sources which apply to the whole data set or error sources 
which vary within the data set. TerraMatch can solve correction parameters for the whole data set, 
for groups of strips or individual correction parameters for each strip.

TerraMatch is loosely integrated with TerraScan. In order to run TerraMatch, some pre-processing 
steps with TerraScan are required but those tasks can be performed by another user at another 
workstation.

General data requirements
The input data must meet some requirements to enable the algorithms to work properly:

• The data set must contain multiple strips which overlap each other. Alternatively, a single 
strip can be compared against a dense set of known points.

• The data set must contain some well defined surfaces -- matching can not be performed if all 
the data are hits in forest canopy where no meaningful surfaces can be constructed.

• Time-stamped trajectory information must be imported into TerraScan.
• A trajectory must not overlap itself. Any trajectories which make a 180 degree turn and return 

over itself, have to be split into separate parts using TerraScan.
• Laser points must be linked to trajectory positions so that TerraMatch can derive the laser 

scanner position and orientation for each laser point. This requires that laser points have strip 
numbers and time stamps matching the trajectory time stamps and numbers.

• Laser points on suitable surfaces have to be classified in each strip independently. This may 
involve automatic ground classification and/or manual classification of suitable sloped 
surfaces such as building roofs.

The specific data requirements for different processing workflows are described in Chapter 
Methods of Strip Adjustment on page 15.
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Terra application family
TerraMatch is just one in a full family of civil engineering applications. Almost all Terra 
applications are tightly integrated with MicroStation presenting an easy-to-use graphical interface 
to the user.

TerraBore is a solution for reading in, editing, storing and displaying bore hole data. You can 
triangulate soil layers with the help of TerraModeler.

TerraModeler creates terrain surface models by triangulation. You can create models of ground, 
soil layers, or design surfaces.  Models can be created based on survey data, graphical elements, 
laser data, or XYZ text files.

TerraPhoto rectifies digital photographs taken during laser scanning survey flights and produces 
orthorectified images.

TerraPipe is used for designing underground pipes.  It gives you powerful tools for designing 
networks of drainage, sewer, potable water. or irrigation pipes.

TerraScan processes laser scanning data. It reads in laser points from text or binary files and lets 
you view the point cloud three dimensionally, classify the data, and create vector data based on 
the points.

TerraSlave is a stand-alone application that processes TerraScan macros. It enables distributed 
processing and scheduling tasks to gain optimal time and working performance.

TerraStereo is a stand-alone application for viewing very large point clouds in mono and stereo 
mode. It utilizes advanced point rendering techniques and the graphics card memory in order to 
display huge amounts of points.

TerraStreet is an application for street design.  It includes all the terrain modeling capabilities of 
TerraModeler. The street design process starts with the creation of  horizontal and vertical 
geometries for street alignments.

TerraSurvey reads in survey data and creates a three dimensional survey drawing. The 
application recognizes a number of survey data formats automatically.
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3 Installation

Hardware and software requirements
TerraMatch is built on top of MicroStation. You must have a computer system capable of running 
this CAD software.

To run TerraMatch, you must have the following:

• Pentium or higher processor
• Windows 8, 7, Vista, XP, or 2000 (64-bit version recommended)
• mouse
• 1024*768 resolution display or better
• 1 GB RAM
• MicroStation V8, MicroStation V8i (Select Series 2 or higher) or Map PowerView. Check 

Terrasolid’s web pages for a more detailed overview of compatible MicroStation versions.

Installation of TerraMatch requires about 1 MB of free hard disk space.

Installation media
TerraMatch may be delivered on CD/USB-Stick or as a zip file.

A zip package only contains the actual software - it does not include the PDF Users’ Guide.

A Terra Installation CD/USB-Stick includes the software and the on-line documentation. When 
you install from the CD/USB-Stick, the software and the documentation are copied to your hard 
disk. The CD/USB-Stick may include versions for multiple environments. You should locate the 
directory which corresponds to your operating system and MicroStation version.

Directory on CD/USB For operating system For MicroStation
\setup\eng Windows V8 or V8i
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Installation from zip file
To install TerraMatch from zip file:

1. Unpack the zip archive with any zip file manager.
2. Start SETUP.EXE which is part of the zip archive.

This may open a dialog confirming the execution of SETUP.EXE and/or prompting for the 
administrator password.

The installation program needs to know where MicroStation has been installed. It 
automatically searches all local hard disks to find the MicroStation directory.

The installation dialog opens:

3. Enter the directory where to install TerraMatch.

The default path is C:\TERRA. You may change this to another location. The specified 
directory is created automatically if it does not exist.

4. Check the MicroStation directory. Replace the path if the correct location was not found 
automatically.

5. Click OK to start the installation.

When the installation is finished, a message is displayed.

See chapters Installation Directories on page 95 and Configuration Variables on page 96 for 
more information.

Installation from CD/USB-Stick
To install TerraMatch from CD/USB-Stick:

1. Insert the Terra Installation CD/USB-Stick.
2. Locate the correct directory which corresponds to your computer configuration.
3. Start SETUP.EXE from that directory.

The installation program tries to determine where MicroStation has been installed and opens 
the Terra Setup dialog:
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4. Enter the directory where to install the application(s).

The default path is C:\TERRA. You can change this to another location. The specified 
directory is created automatically, if it does not exist.

5. Check the MicroStation directory. Replace the path if the correct location was not found 
automatically.

Alternatively, you can use the Scan button to automatically search the hard disk for the 
MicroStation installation or you can use the Browse button to locate the MicroStation 
executable yourself.

6. Check the MicroStation version information in the Version field. Select the correct version 
if it was not detected automatically.

7. Click OK to continue.

This opens another Terra Setup dialog:

8. Check TerraMatch for MicroStation item in the dialog.

You may select other applications as well for which you have installation files. You would 
normally install TerraScan for MicroStation as well if it is not yet installed on your 
computer.

9. Click OK to start the installation.

A message is display when the installation is finished.

See chapters Installation Directories on page 95 and Configuration Variables on page 96 for 
more information.
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4 Starting TerraMatch

Start TerraMatch
TerraMatch is an MDL application that runs on top of MicroStation.

To start TerraMatch:

1. Select MDL Applications command from the Utilities menu in MicroStation.

The MDL dialog opens:

2. In the Available Applications list, select TMATCH.
3. Click on the Load button.

OR

1. Key in MDL LOAD TMATCH.

TerraMatch adds an Applications menu to MicroStation’s menu bar and opens the TerraMatch 
tool box.

The Available Applications list shows all MDL applications that MicroStation is able to locate. 
MicroStation searches for MDL applications in the directories listed in MS_MDLAPPS 
configuration variable. If MicroStation can not find TMATCH.MA, you should check the value 
assigned to this configuration variable. Make sure the directory path of the TMATCH.MA file is 
included in the variable. To view configuration variables, select Configuration command from 
the Workspace menu in MicroStation. See also Sections Installation Directories on page 95 and 
Configuration Variables on page 96 for more information.
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Unload TerraMatch
TerraMatch is unloaded automatically when you exit MicroStation. Sometimes you may want to 
unload the application while continuing to work with MicroStation. This frees up the memory 
reserved by TerraMatch.

To unload TerraMatch:

1. Select MDL Applications command from the Utilities menu in MicroStation.

The MDL dialog opens:

2. In the Loaded Applications list, select TMATCH.
3. Click on the Unload button.

OR

1. Key in MDL UNLOAD TMATCH.

This unloads the application.
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5 Methods of Strip Adjustment

Find match vs. Tie Lines
There are two methods of strip adjustment in TerraMatch, Find Match and Tie Lines. The 
methods are compared in the following table.

Find Match Tie Lines
Tool Find Match
Tool Find Fluctuations

Tool Find Tie Line Match
Tool Find Tie Line Fluctuations

Surface-to-surface matching Feature-to-feature matching
Only one type of observation Several types of observations
More time consuming adjustment Less time consuming adjustment
New (better) observations for each iteration Old observations included for each iteration
No manual observations Manual observations possible

Input data
• trajectories with time stamp
• laser points linked to trajectories and classified 

into ground (and optional buildings) per strip
• (optional) ground control points

• trajectories with time stamp
• tie lines derived from laser points, linked to 

trajectories by time stamp
• (optional) ground control points

Solvable parameters
• easting, northing, elevations shifts
• heading, roll, pitch shifts
• mirror scale
• easting, northing, elevations drifts
• heading, roll, pitch drifts
• fluctuating elevation

• easting, northing, elevations shifts
• heading, roll, pitch shifts
• mirror scale
• fluctuating easting/northing, elevation, roll, 

pitch

Observations
• triangulated model from each strip surface
• compares overlapping laser points and ground 

control points against this surface
• translates observed difference and gradient to 

heading, roll, pitch, elevation difference

• surface/section lines - follow direction of a 
surface

• ground lines/points - located on paint markings
• roof intersection lines - located at an 

intersection of two roof surfaces
• known lines/points - located at known point 

locations
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Tie line types
There are different types of tie lines which can be created depending on the objects and features 
available in the laser data set. An overview of the tie line types is given in the following table and 
examples are shown in the figures on the next page.

Abbreviations:
GCP - ground control point h - heading x - easting
ALS - airborne laser scanning data r - roll y - northing
MLS - mobile laser scanning data p - pitch z - elevation

Tie line type Placement method Possible locations
Added 
value for 
solving

Input data

Ground point • manual • end point of paint 
markings on the 
ground

• circular objects on 
the ground

• h r p
• xy z

• high point 
density ALS

• MLS

Known xyz point
Known xy point

• import from text 
file or selected 
vectors

• automatic/manual

• GCP on bright signal 
marker on dark hard 
surface

• GCP on endpoints of 
paint markings on 
the ground

• h r p
• absolute 

xy z or xy

• high point 
density ALS

• MLS
• signal marker 

definition
• GCP text file 

or vector data
Known z point • import from text 

file or selected 
vectors

• manually

• GCP on the ground 
without known xy

• h r p
• absolute 

z

• ALS
• MLS
• GCP text file 

or vector data
Xy point • manually • building corners

• poles
• h
• internal 

xy

• high point 
density ALS

• MLS
Elevation point • import from text 

file or selected 
vectors

• half-automatic

• surfaces • internal z • ALS
• MLS

Ground line • manual • along paint 
markings on the 
ground

• h r p
• xy z

• high point 
density ALS

• MLS
Section line
• flat ground

• automatic search
• manual

• flat, hard surfaces • r
• z

• ALS
• MLS
• flat ground 

classification
Section line
• surface

• automatic search
• manual

• surfaces • h r p
• z

• ALS

Section line
• vertical walls

• automatic search
• manual

• building walls, 
• vertical poles

• h r p
• xy z

• MLS

Known line • import from text 
file

• automatic/manual

• point on linear paint 
markings

• h
• r p (ALS)
• xy z

• high point 
density ALS

• MLS
Roof intersection 
line

• automatic search • intersection of two 
roof surfaces

• h r p
• xy z

• ALS
• building 

classification



Examples
Known xyz or xy point Known line

Known z point

Ground point Ground line

Section line - flat ground Section line - surface

Section line - vertical wall Roof intersection line

Xy point Elevation point



Page 18
5 Methods of Strip Adjustment

Fluctuating corrections with tie lines

Besides the correction of systematic shifts, tie lines can be used for applying corrections that 
change over time (fluctuating corrections, drifts). This is essential for correcting local drifts of the 
trajectory solution which occur, for example, if there is a failure of GPS signal during a flight or 
drive. Fluctuating corrections are the most important part of improving the accuracy of mobile 
laser data, but they are useful for airborne data as well.

If no control measurements are involved, the software computes a guessed location for the tie line 
feature which corresponds to the average of the feature location between the laser data strips. If 
the trajectory solution provides estimates of the positional accuracy for each drive pass, these 
estimates translate to weight factors when computing the average location. This results in lower 
accuracy strips getting a bigger correction and better accuracy paths getting a smaller correction.

If a control measurement is used, the observed correction is the difference between the tie line 
feature location in the laser data and the location of the control measurement.

The actual correction for the laser data is applied as a correction curve which changes over time. 
The correction curve is built by computing a correction for each tie line observation. The 
correction is a linear interpolation between two consecutive observations.

Exaggerated xyz correction vectors for one strip.

The user can specify how much the correction curve is smoothed. The smoothing of the correction 
curve involves the accuracy estimates for trajectory positions. Bigger corrections values are 
applied for positions where the accuracy estimate is worse. A factor determines, how fast the 
corrections curve changes can be. A small factor results in a smoother curve. This should be used 
if the tie lines are not so good and may contain outliers. A bigger factor results in a less smooth 
curve and the single tie line observations get more influence in the final solution. This should be 
used for good tie lines.

If no smoothing is applied, each tie line observation fully effects the final correction values. This 
is recommended for checking the tie lines and finding out erroneous tie lines. Otherwise, a 
smoother correction curve is less sensible to remaining inaccurate tie line observations. No 
smoothing may also be used if correction values are computed based on accurate tie points 
collected from ground control points for which the exact xyz coordinate values are known.
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6 Workflow Overview

Airborne laser data

Calibration workflow

TerraMatch can be used to solve the mirror scale parameter and the misalignment between the 
laser scanner and the inertial measurement unit (IMU). The misalignment is expressed as heading, 
roll and pitch angular correction values which need to be known for every laser scanner system.

Different laser scanners may require additional calibration parameters as well. Those must be 
solved using more manual methods with TerraScan or with system specific software.

Flight pattern
The optimal site for a calibration flight contains both flat and sloped surfaces which do not have 
disturbing surface objects such as low vegetation. The most commonly used target area for 
calibration is an airport as it is easily accessible and most often contains suitable surfaces, such as 
the run ways and sloped building roofs.

The minimum flight pattern for calibration is four flight passes over the same area in a cross like 
pattern where the slopes surfaces are located at the center of the cross, as shown in the figure 
below.

You may consider some additional flight passes which may improve the quality of the calibration:

• An additional flight pass for which the sloped surfaces are located at the right of left edge of 
the corridor covered. This helps to differentiate pitch and heading from each other.

• Additional flight passes at a higher or a lower altitude.

Processing steps
The processing of a calibration flight can be outlined with the following steps:

1. Solve GPS trajectories.
2. Compute xyz laser points with system specific software using the last known calibration 

values.
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3. Import trajectories into TerraScan and transform them to any coordinate system.
4. Split any trajectories which overlap themselves.
5. Import time-stamped laser points into TerraScan and transform them to the same coordinate 

system.
6. Make sure that the flightline numbering of the laser points matches trajectory numbers (in 

TerraScan, use Deduce using time command from Flightline pulldown menu).

Continue according to the matching method.

Surface-to-surface matching:

7. Classify low points.
8. Classify ground separately for each flightline.
9. (Optional) Classify some buildings separately for each flightline.
10. Smoothen ground surface if most of it is asphalt or some other hard surface.
11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole 

data set.
12. Add the result values to the correction values used when computing the xyz points in step 2. 

Tie line-based matching:

7. Search for tie lines of type Surface lines. This does not require any classification of the laser 
points.

8. Run Find Tie Line Match and solve for heading, roll, pitch and mirror scale corrections for 
the whole data set.

9. Add the result values to the correction values used when computing the xyz points in step 2. 

The laser scanner may have operation modes which make calibration easier such as profile mode. 
If such a mode is available, it should be used to solve the pitch correction value first. Then 
TerraMatch should be used to solve for heading and roll correction only.
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Project workflow

Even though the system has been calibrated, you may still find systematic errors in project data. 
TerraMatch can be used with actual project data to solve mismatches between laser data from 
different flightlines or between laser data and known points.

All parallel flightlines covering a project area should have a crossing flightline at both ends. For 
large project areas it is recommended to fly at least two or more crossing flightlines over sloped 
open terrain in order to provide good data for the matching task. Known points (ground control 
points) should be distributed close to the corners or edges of the project area.

As the project data volume can be huge, it is desirable to minimize the number of steps in the 
processing workflow. You probably want to run TerraMatch only if you notice that there are 
significant mismatches in the laser data.

Another difficulty with project data is that you do not know the nature of the errors beforehand. 
Mismatches may be a result of mistakes made during the setup of GPS reference stations, during 
computing trajectories or during operation of the airborne system. At some point within the 
correction workflow you must establish what parameters need to be corrected.

Processing steps
The general project workflow can be outlined with the following steps:

1. Solve GPS trajectories.
2. Compute xyz laser points with system specific software using the last known calibration 

values.
3. Import trajectories into TerraScan.
4. Import time stamped laser points into TerraScan.
5. Compare flightlines visually in cross sections. Try to locate sloped surfaces both along 

flight direction and perpendicular to flight direction.
6. If no significant mismatches are visible, you may skip the consecutive steps and continue 

with the normal processing workflow.
7. Classify low points.
8. Classify ground for each fligthline. If necessary, exclude water areas from the ground class.
9. (Optional) Locate areas which are best suited for matching (crossing flightlines, visible 

clean sloped surfaces). Create a TerraScan project with blocks only in those areas.
10. (Optional) Classify buildings for each flightline at the locations which are best suited for 

matching.

Continue according to the matching method.

Surface-to-surface matching:

11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole 
data set.

Apply the correction if it is significant.

12. Run Find Match and solve for elevation or roll + elevation correction for individual 
flightlines.

Apply the correction if it is significant.

13. Run Find Fluctuations and solve for fluctuating elevation correction.

Apply the correction if it is significant.

Tie line-based matching:

11. Search for tie lines of type Surface lines based on ground and (optional) building class.



Page 22
6 Workflow Overview

12. Run Find Tie Line Match and solve for heading, roll, pitch and mirror scale corrections for 
the whole data set.

Apply the correction to the tie lines and the laser data if it is significant.

13. Check the tie lines for worse observations.
14. Run Find Tie Line Match and solve for heading, roll, pitch and elevation corrections for 

flightline groups (if there are any). Depending on the system, solve for mirror scale 
corrections per flightline groups as well.

Apply the correction to the tie lines and the laser data if it is significant.

15. Check the tie lines for worse observations.
16. Run Find Tie Line Match and solve for heading, roll, pitch and elevation corrections for 

individual flightlines.

Apply the correction to the tie lines and the laser data if it is significant.

17. Check the tie lines for worse observations.
18. Run Find Tie Line Fluctuations and solve for fluctuating elevation corrections.

Apply the correction to the laser data if it is significant.

After each Apply corrections step you should check the flightlines visually in cross sections or 
using distance coloring to determine if the correction step improved the data. You have to decide 
if the correction was good or if you need to go back one step and try solving parameters with 
different settings.

Multi-day projects
Use GPS standard time to avoid conflicts between flight sessions with identical GPS seconds-of-
week time stamps. There are tools in TerraScan for converting between GPS seconds-of-week and 
GPS standard time and vice versa. The tools are applicable to trajectories and to laser data.

Apply a group number to trajectories for each flight session (day 1 = trajectory group 1, day 2 = 
trajectory group 2, etc.). Optionally apply also a quality tag to trajectories of a flight session, e.g. 
if flight conditions are worse on one of the days.

Reduce the amount of data for processing as much as possible. This includes thinning of 
trajectories during the import, but also reducing the number of blocks for matching in a TerraScan 
project. Use only blocks that are suitable for the matching task and only classes that are necessary 
(e.g. ground, building classes).

For adding a new data set to an already matched data set, apply quality “bad” to the trajectories of 
the new data set and quality “normal” or “good” to the trajectories of the old data set. Use Find 
Match or Find Tie Line Match and solve for corrections for the “bad” flightlines only.
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Mobile laser data

Calibration workflow

The task of mobile scanner calibration includes solving misalignment angles heading, roll and 
pitch for each scanner in a system. Misalignment issues are visible in the point cloud as differences 
between points of different drive paths and points of different scanners. The misalignment is more 
and more noticeable in the data the longer the distance is from the scanner. It has practically no 
effect on close-by objects, for which rather trajectory xyz inaccuracies dominate.

Potential objects for mobile scanner calibration are vertical planar surfaces, such as building 
walls, building corners and horizontal hard planar surfaces. A heading misalignment effects the 
xy location of a vertical surface or a building corner while roll and pitch effect the verticality of 
vertical surfaces as well as the elevation of horizontal surfaces in left/right (roll), forward/
backward (pitch) direction. Other usable objects are vertical poles and overhead wires, but those 
objects have disadvantages, such as being off from vertical or varying diameters (poles) and 
possible movement (wires).

The tie line types used for calibration are Section lines on planar horizontal or vertical surfaces 
and Xy points, for example on building corners. More information about different tie line types 
can be found in section Tie line types on page 16.

Drive pattern
A good calibration side is an open space with hard surface ground and without disturbing objects 
such as cars, trees, etc. At least on one side there should be a larger building wall or another large 
vertical surface without many detailed structures. The calibration drive includes two drive paths 
in opposite direction parallel to the vertical surface, two drive paths in opposite direction 
perpendicular to the vertical surface and (optionally) two diagonal drive paths towards or away 
from the vertical surface. Another option is to drive over an intersection of two road with at least 
two buildings next to the crossing, both roads in opposite directions. The two calibration drive 
pattern are illustrated below.

Only a suitable drive pattern ensures that all calibration parameters can be solved based on the 
laser data. The drive pattern described here are optimized for calibrating scanner systems that 
contain two scanners which are rotated horizontally by about 45 degree off from the driving 
direction.

Drive pattern option 1, e.g. on a parking lot Drive pattern option 2, road crossing
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Processing steps
The processing of a calibration data set can be outlined with the following steps:

1. Create GPS trajectories.
2. Compute xyz laser points with system specific software using the last known calibration 

values.
3. Import trajectories into TerraScan and transform them to any coordinate system.
4. (Optional) Import the accuracy estimate file for the trajectory.
5. Import time-stamped laser points into TerraScan and transform them to the same coordinate 

system. Assign the scanner number during the import, e.g. based on the file or folder name. 
Save the laser data in LAS or TerraScan Fast Binary format which are able to store a 
scanner number for each laser point.

6. Split trajectories to create separate trajectory lines for each drive path.
7. Make sure that the drive path numbering of the laser points matches trajectory numbers (in 

TerraScan, use Deduce using time command from Flightline pulldown menu).
8. Classify points by scanner number to separate the different scanners.
9. Remove unnecessary points, e.g. from stops, sharp turns or long range measurements.
10. Classify points on hard planar ground surfaces close to the trajectory lines.
11. Search tie lines of type Section lines on vertical walls.
12. Search tie lines of type Section lines on flat ground.
13. (Optional) Add more tie lines manually if the automatically found tie lines do not give a 

good result. This may be the case if the drive pattern was not optimal for the calibration 
task.

14. Run Find Tie Line Match and solve for heading, roll, and pitch for the whole data set.
15. Add the result values to the correction values used when computing the xyz points in step 2. 
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Project workflow

For mobile scanning projects, the quality of GPS positioning and thus, the quality of the trajectory 
is usually not as good and constant as for airborne projects. This is caused by GPS failures due to 
large buildings, trees, rock formations, etc. along the roads or rails. The positioning accuracy of 
the trajectory can vary a lot during a drive session. Thus, the dominant error source for inaccurate 
data is the trajectory xyz positioning which shows up close to the scanner location.

Positional adjustment of mobile laser data in TerraMatch is based on tie line observations. These 
are typically collected on flat ground and/or on high intensity features such as paint markings.

A tie line observation can utilize ground control points or it can be for internal comparison only 
(multiple drive passes seeing the same location). It is recommended to measure ground control 
points along the road or other survey corridor at regular distances. The distances between control 
measurements can vary depending on the required accuracy level and the accuracy of the 
trajectory. Internal tie line observations should be added between the control measurements 
whenever the same location has been seen by multiple drive paths.

Ground control points can be located on corners of strong paint markings, at end points of thin 
strong paint markings or in the center of weaker paint markings. The latter type of control points 
is then used for partial xy control.

Instead of using paint markings for control measurements, signal markers of a specific pattern can 
be used as ground control points. This has the advantage that the software can find a bright signal 
marker on a dark surface automatically based on the intensity information of the laser points. See 
Signal markers category on page 58 for more information about signal markers in TerraMatch.

More information about the different tie line types and the positional adjustment of mobile laser 
scanner project data can be found in Sections Tie line types on page 16 and Fluctuating 
corrections with tie lines on page 18.

General project strategy
The general strategy of a mobile scanning project can be outlined as follows:

1. Collect some control measurements.
2. Execute LiDAR / image survey. Drive every place at least twice.
3. Check the system calibration.
4. Find locations of bad trajectory accuracy using color by RMS values for trajectories. 

Compare the drive paths visually.
5. Collect additional control measurements at locations where the trajectory positioning is bad.
6. Adjust xyz positioning of the laser data by matching drive paths to each other and to control 

measurements. This probably involves several processing steps.
7. Remove less accurate data, e.g. long range measurements where short range measurements 

exist, and cut off overlapping drive paths.
8. Continue processing the data according to the project requirements.



Page 26
7 Working with Tie Lines

7 Working with Tie Lines

Tie line window
The tie line mode is started from the Define Tie Lines tool in the Tie line tool box. The tool opens 
the Tie lines window:

The window provides pulldown menus with commands for working with tie lines. These 
commands are described on the following pages. If a tie line file is loaded, it shows for each tie 
line the tie line type and the following information in columns 1-6:

1. strip number
2. scanner number
3. time stamp
4. XY mismatch at tie line location
5. Z mismatch at tie line location
6. (for MLS data sets only) misalignment angle for which the tie line adds some valuable 

correction

The Define Tie Lines tool can also arrange the views in MicroStation in a way that is suitable for 
working with tie lines. The view setup includes:

• Full view - all tie lines are displayed in a top view.
• Entry view - one selected tie line position is displayed in a horizontal section or top view. 

This view is used for viewing or placing close-to-horizontal tie lines manually.
• Detail view - one selected tie line with all its positions is displayed in a horizontal section or 

top view.
• Wall entry view - one selected tie line position is displayed in a vertical section view. This 

view is used for viewing or placing close-to-vertical tie lines manually.
• Wall detail view - one selected tie line with all its positions is displayed in a vertical section 

view.

The views are updated automatically depending on the selected tie line type.
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File pulldown menu
The File pulldown menu contains commands for creating, opening and saving tie line files, for 
restoring observations, for importing control measurements, for searching tie lines automatically, 
and for creating a statistical report.

To: Choose menu command:
Create a new tie line file File / New
Open a tie line file File / Open
Save an existing tie line file File / Save
Save tie lines to a new file File / Save as
Restore observations from a tie line file File / Restore observations
Import control points as known lines File / Import known lines
Import control points as known or elevation points File / Import points
Search tie lines automatically File / Search tie lines
Create a statistical report from tie lines File / Output report
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File / New

New command empties the tie line window and thus, opens a new tie line file. It also removes the 
active tie lines from the memory.

File / Open

Open command lets you open a tie line file from the hard disk. Opening a tie line file replaces any 
active tie lines with tie lines stored in the file.

File / Save

Save command lets you save changes in the active tie lines to an already existing tie line file.

File / Save as

Save as command saves active tie lines to a tie line file. The tie line file gets the extension .TIL.

File / Restore observations

Restore observations command restores original observations from a tie line file that has been 
saved earlier. It can be used, for example, to restore the original observations after applying 
corrections temporarily and removing bad tie lines.

To filter bad tie lines and restore observations:

1. Collect tie lines and save them into a file.
2. Solve correction(s).
3. Apply Correction to the loaded tie lines.
4. Search for worst observations and remove bad tie lines. Erroneous tie lines usually stand out 

more clearly after corrections have been applied.
5. Restore original observations from the tie lines file saved in step 1.
6. Save the filtered tie lines.

File / Reduce to single line

Reduce to single line command reduces tie lines to single line observations. As a result, each tie 
line is placed in only one strip. This is useful for solving calibration issues of a multi-scanner 
system because trajectory drift issues do not effect the solution for the whole data set anymore. 

To reduce tie lines to single lines:

1. Collect tie lines with setting Separate scanners on. See Define Tie Lines on page 84 for 
more information.

2. Select Reduce to single line command from the File pulldown menu.

A dialog is shown which asks for confirmation of the step.

3. Click OK in order to reduce the tie lines.
4. Save the tie lines into a new tie line file.
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File / Import known lines

Import known lines command starts the import of control measurements that have been 
measured on linear paint markings. The import results in tie lines of the type known line which 
provide a partial xy control.

The control measurements have to be stored in a text file where each line includes the separated 
x, y, and z coordinates for one control point.

The command requires that a project is loaded in TerraScan where the laser data provides the input 
for placing the tie lines.

To import control measurements as known lines:

1. Select a vector element which defines the direction in which paint markings run if you want 
to use the automatic tie line placement mode.

2. Select Import known lines command from the File pulldown menu.

This opens the Import known lines dialog:

3. Select settings and click OK.

This opens another dialog for selecting the text file with control measurement coordinates.

4. Select the text file and click Open.

If the entry mode is Manual, the control measurements are added to the tie line list in the Tie 
lines window. Continue with placing the tie line locations manually.

If the entry mode is Auto line search, the software tries to place the tie lines automatically 
at the location of the control measurements. Continue with checking the tie lines and placing 
tie lines manually where the automatic line search has failed.

Setting: Effect:

Entry mode

Defines how tie lines for control measurements are placed:
• Manual - all positions are digitized manually.
• Auto line search - the software places the tie lines 

automatically.
Line length Length of a tie line that the software places automatically.

Angle within Maximum angle difference between observed tie line and 
selected vector element.
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File / Import points

Import points command starts the import of control measurements that have been measured on 
corners or end points of paint markings, or on signal marker locations. The import results in tie 
lines of the type known xyz, known xy, known z, or elevation point.

The control measurements can be provided in a text file where each line includes the separated x, 
y, and z coordinates for one control point. Another option are point elements drawn in the design 
file at the control measurement locations.

The command requires that a project is loaded in TerraScan where the laser data provides the input 
for placing the tie lines. If signal markers are used for placing known xyz or xy points, the shape 
of the signal marker must be defined in TerraMatch Settings. See Signal markers category on 
page 58 for more information about signal markers.

To import control measurements as points:

1. Select the control points in the design file using MicroStation Selection tool if you want to 
import the control points based on selected vectors.

2. Select From text file or From selected vectors command from the File / Import points 
pulldown menu.

This opens the Import points dialog:

Setting: Effect:
Point type Type of tie lines that are created from the control measurements.

Signal marker Signal marker name defined in TerraMatch settings. Required 
for importing known xyz or known xy points.

Rotation

Defines the rotation for a signal marker:
• Free - the signal marker can be rotated freely compared to the 

travel direction.
• Travel direction - the rotation of the signal marker is fixed. 

The travel direction is extracted from the closest trajectory.

Min contrast Intensity contrast between bright parts of a signal marker and the 
dark background.

Use Laser points used for placing the tie lines: project points or 
loaded points.

Laser project Path to a TerraScan project. This is only active if Use is set to 
Project points.

Fit radius Area within which points are used to calculate the tie line 
location.
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3. Define settings and click OK.

If the import is based on selected vectors, the software starts the import and places the tie 
lines at the control measurement locations. Continue with checking the tie lines and placing 
tie line positions manually where the automatic placement failed.

If the import is based on text file, another dialog opens for selecting the text file.

4. Select the text file and click Open.

This starts the import and the software places tie lines at the control measurement locations. 
Continue with checking the tie lines and placing tie line positions manually where the 
automatic placement failed.

After the import has finished, an information dialog is shown. It displays the number of created 
known points vs. the number of control measurements found in the text file or selection set.

Require Point density required for placing the tie line.
Max angle Maximum allowed angle of the surface at a tie line location.

Setting: Effect:
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File / Search tie lines

Search tie lines command opens the Search tie lines dialog from which the automatic tie line 
search can be started. With the automatic tie line search you can search for tie lines of the type 
section line on vertical walls, flat ground, or on surfaces, as well as for roof intersection lines. 

The automatic tie line search can be based either on laser points loaded into TerraScan or on a 
TerraScan project. The different tie line types are searched for in different laser point classes 
depending on the settings in the Define Tie Lines dialog.

The different tie line types use classes as follows:

• Vertical walls - wall classes
• Paint lines - ground classes
• Flat ground - ground classes
• Surface lines - ground classes
• Roof intersections - roof classes

The tie line settings can be changed between several tie line searches using the View / Settings 
command from the View pulldown menu. When searching first for one tie line type and then for 
another, the new tie lines are added to the active tie lines at the end of the tie line list.

To search tie lines:

1. Select Search tie lines command from the File pulldown menu.

This opens the Search tie lines dialog:

2. Define settings and click OK.
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The software starts the search for tie lines. As a result, tie lines of the selected type are added 
to the list of active tie lines. The amount of tie lines found is displayed in an information 
dialog after the search is completed.

Setting: Effect:

Use Laser points used for placing the tie lines: project points or 
loaded points.

Ignore first/intermediate 
echo locations

If on, locations where there are laser points of first or 
intermediate echo types are ignored.

Laser project Path to a TerraScan project. This is only active if Use is set to 
Project points.

Save results after each 
block

If on, the tie lines are saved automatically into a file after the 
search is completed for a block of a project. This is only active if 
Use is set to Project points.

Spacing Distance between two tie line locations. The value determines 
the density of the tie lines.

Find vertical walls

Search for tie lines on vertical walls or structures within the Wall 
classes defined in the settings.
• Length - length of a tie line.
• Depth - depth of a section where the software tries to fit the 

tie line to the laser points.
• Max angle - maximum allowed angle off from vertical for a 

tie line placed on a vertical structure.

Find paint lines Search for tie lines on bright paint markings using a selected 
vector of known points along the center of paint marking.

Find flat ground

Search for tie lines on flat ground or horizontal surfaces within 
the Ground classes defined in the settings.
• Direction - direction of a tie line relative to the movement 

direction: Along movement or Perpendicular.
• Length - length of a tie line.
• Depth - depth of a section where the software tries to fit the 

tie line to the laser points.
• Max angle - maximum allowed angle off from average 

between the tie lines at the same location.

Find surface lines

Search for tie lines on surfaces within the Ground classes 
defined in the settings.
• Direction - direction of a tie line relative to the movement 

direction: Along movement, Perpendicular, or Slope 
direction.

• Length - length of a tie line.
• Depth - depth of a section where the software tries to fit the 

tie line to the laser points.
• Max angle - maximum allowed angle off from average 

between the tie lines at the same location.

Find roof intersection 
lines

Search for tie lines along intersections of roof planes within the 
Roof classes defined in the settings.
• Length - length range of a tie line.
• Min width - minimum width of the roof planes on both sides 

of the tie line.
• Planarity - distance tolerance between point and plane 

equation of the planar roof patch it belongs to.
• Min slope - minimum slope off from horizontal of the roof 

planes.
• Require - number of observations required for accepting a tie 

line location. Minimum is 2 observations (from 2 strips). 
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File / Output report

Output report command displays a statistical report that is created based on the active tie lines. 
The content of the report varies depending on the types of tie lines that are available for calculating 
the statistics. The report can include information about:

• average mismatches in 3d, xy, z
• average leaning of walls
• statistics for known points/lines including amount of tie points/lines; transformation value 

recommendations; average magnitude, RMS values, maximum values, observation weights 
for x, y, and z

• statistics for internal observations including amount of tie points/lines; average magnitude, 
RMS values, maximum values, observation weights for x, y, and z

• average magnitudes per strip for x, y, and z

A text file can be saved or the report can be printed from the Tie line report window by using the 
Save as text file command or Print command from the File pulldown menu. The window size 
can be changed using the commands from the View pulldown menu.
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Line pulldown menu
The Line pulldown menu contains commands for adding tie lines manually or half-automatically, 
for modifying the type of a tie line, for cleaning up tie lines, and for deleting tie lines.

To: Choose menu command:

Add tie lines of a specific type manually or half-
automatically based on laser data that is loaded in 
TerraScan. See Tie line types on page 16 for more 
information about the different tie line types.

Line / Add ground point
Line / Add xy point
Line / Add elevation point
Line / Add known point
Line / Add ground line
Line / Add section line
Line / Add known line

Modify the type of a tie line Line / Edit
Delete undefined tie line positions Line / Clean
Delete tie lines Line / Delete
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Line / Add ground point

Add ground point command lets you place a tie line of the type ground point.

To add a ground point:

1. Select Add ground point command from the Line pulldown menu.

This opens the Add Ground Point dialog:

2. Define settings that fit to the laser data.
3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Setting: Effect:
Require Point density required for placing the tie point.

Fit radius Area within which laser points are used to calculate the tie 
point’s elevation.

Display circle
If on, a circle of the specified diameter is displayed at the mouse 
pointer location. This helps to place a ground point accurately, 
for example on circular objects.
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Line / Add xy point

Add xy point command lets you place a tie line of the type xy point.

To add an xy point:

1. Select Add xy point command from the Line pulldown menu.

This opens the Add Xy Point dialog:

2. Define settings that fit to the laser data.
3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Line / Add elevation point

Add elevation point command lets you place a tie line of the type elevation point.

To add an elevation point:

1. Select Add elevation point command from the Line pulldown menu.

This opens the Add Elevation Point dialog:

2. Define settings that fit to the laser data.
3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Setting: Effect:
Require Point density required for placing the tie point.

Setting: Effect:
Require Point density required for placing the tie point.

Fit radius Area within which laser points are used to calculate the tie 
point’s elevation.
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Line / Add known point

Add known point command lets you place a tie line of the type known xyz, known xy, or known 
z point. This requires that control measurements are available and drawn as point elements into 
the design file.

To add a known point:

1. Select Add known point command from the Line pulldown menu.

This opens the Add Known Point dialog:

2. Select settings that fit to the laser data and to the known points that are used.
3. Snap to the control point drawn in the design file in order to define the location for the tie 

line in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions. 
You may also change the type of the tie point using the Line / Edit command, for example from 
known xyz to known z, if you are not able to place the tie point at the accurate xy location.

Setting: Effect:

Type

Known tie point type:
• Known xyz - xyz coordinates are used for the tie point.
• Known xy - xy coordinates are used for the tie point.
• Known z - z coordinate is used for the tie point.

Require Point density required for placing the tie point.

Fit radius Area within which points are used to calculate the tie point 
location.
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Line / Add ground line

Add ground line command lets you place a tie line of the type ground line.

To add a ground line:

1. Select Add ground line command from the Line pulldown menu.

This opens the Add Ground Line dialog:

2. Select settings that fit to the laser data.
3. Select an approximate location for the tie line in the Full view.

This updates the Entry view and Detail view and adds the tie line to the list.

4. (Manual mode) Place the tie line in the Entry view according the the laser data for each tie 
line position.

OR

5. (Auto line search mode) Place the tie line in the Entry view according the the laser data for 
the first tie line position. The software tries to find the other tie line positions automatically.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Setting: Effect:

Entry mode

Defines how the tie line is placed:
• Manually - all positions are digitized manually.
• Auto line search - only the first position is placed manually, 

the other positions are found automatically.
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Line / Add section line

Add section line command lets you place a tie line of the type section line.

To add a section line:

1. Select Add section line command from the Line pulldown menu.

This opens the Add Section Line dialog:

2. Define settings that fit to the laser data.
3. Select an approximate location for the tie line in the Full view.

This updates the Entry view and Detail view or the Wall entry view and Wall detail view, 
and adds the tie line to the list.

4. Place the tie line in the Entry view or Wall entry view according the the laser data for each 
tie line position.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Setting: Effect:

Section depth Depth of the section that is used for fitting the tie line to the laser 
data.
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Line / Add known line

Add known line command lets you place a tie line of the type known line. This requires that 
control measurements are available and drawn as point elements into the design file.

To add a known line:

1. Select Add known line command from the Line pulldown menu.

This opens the Add Known Line dialog:

2. Define settings that fit to the laser data.
3. Snap to the known point and draw a line at the approximate location of the tie line in the 

Full view.

This updates the Entry view and Detail view and adds the tie line to the list.

4. (Manual mode) Place the tie line in the Entry view according the the laser data for each tie 
line position.

OR

5. (Auto line search mode) Place the tie line in the Entry view according the the laser data for 
the first tie line position. The software tries to find the other tie line positions automatically.

If you are not able to place all tie point positions, you can skip a position by selecting the next 
observation for this tie point. Then use the Line / Clean command to remove undefined positions.

Setting: Effect:

Entry mode

Defines how the tie line is placed:
• Manually - all positions are digitized manually.
• Auto line search - only the first position is placed manually, 

the other positions are found automatically.
Number Number of the known line. Counts up automatically.



Line / Edit

Edit command can be used to change the type of a tie line.

To change the tie line type:

1. Select the tie line.
2. Select Edit command from the Line pulldown menu.

This opens the Tie line information dialog:

3. Select a new tie line type from the selection list.
4. Click OK.

This changes the type of the tie line and updates the information in the tie line list.

Line / Clean

Clean command is used to remove undefined positions from a tie line. There are places where a 
tie line can not be defined for some strips due to obstructions, too low point densities, or 
inappropriate viewing angles. This results in undefined positions which should be deleted from 
the tie line list.

To clean undefined position from a tie line:

1. Select the tie line or one of its positions.
2. Select Clean command from the Line pulldown menu.

This removes all undefined positions from this tie line.

Line / Delete

Delete command is used to delete tie lines from the list. In contrast to Position / Delete command 
from the Position pulldown menu, this command deletes the tie line completely.

Command: Effect:
Selected tie line The selected tie line is deleted.
Inside fence All tie lines inside a fence or selected polygon are deleted.
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Position pulldown menu
The Position pulldown menu includes commands for correcting tie line positions manually, for 
identifying tie lines, for deleting tie line positions, for finding bad tie lines, and for identifying the 
position of the scanner at a tie line location.

A tie line position refers to a tie line at one specific flight or drive path.

To: Choose menu command:
Define the position of a tie line manually Position / Enter position
Select a tie line from a MicroStation view Position / Identify
Delete tie line positions Position / Delete
Find the tie line with the biggest mismatch value Position / Find worst
Find tie lines with mismatch values up to a certain 
threshold

Position / Find
Position / Find next

Show the scanner position for a tie line location Position / Show scanner

Remove closeby tie line observations Position / Thin by travel 
distance

Remove bad tie lines automatically Position / Filter bad
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Position / Enter position

Enter position command lets you place a tie line position manually. This can be used for 
correcting the position of a selected tie line, for example when the automatic placement did not 
work accurately.

To enter the position of a tie line:

1. Select the tie line position for which you want to place the tie line.
2. Load laser data at the tie line location.
3. Select Enter position command from the Position pulldown menu.
4. Digitize the new tie line location in the Entry view according to the laser data.

This updates the location of the tie line and the values in the tie line list.

Position / Identify

Identify command is used to identify a tie line in a MicroStation view with a mouse click. The 
corresponding tie line is selected in the tie line list.

To identify a tie line:

1. Select Identify command from the Position pulldown menu.
2. Move the mouse pointer inside a MicroStation view.

The tie line closest to the mouse pointer is highlighted.

3. Ente a data click in order to select the tie line in the list.

Position / Delete

Delete command is used to delete positions of tie lines. In contrast to Line / Delete command from 
the Line pulldown menu, this command may not delete a tie line completely but only those 
positions that meet the defined settings.

Position / Find worst

Find worst command is used to select the tie line with the largest mismatch value from the list. It 
helps to detect incorrect tie lines or tie lines with exceptionally high mismatch values.

Command: Effect:
Selected position The selected position of a tie line is deleted.
By line Tie line positions of selected strip(s) are deleted.
By scanner Tie line positions of selected scanner(s) are deleted.

By range Tie line positions within a defined distance range from the 
scanner are deleted.
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Position / Find

Find command is used for searching tie lines that have a mismatch larger than a specific threshold 
value. The threshold can relate to different mismatch values, such as elevation, xy, 3D, angular, 
or wall angle mismatch.

Find tie lines:

1. Select Find command from the Position pulldown menu.

This opens the Find tie lines dialog:

2. Define settings and click OK.

The first tie line position with a mismatch larger than the defined threshold is selected in the 
list.

3. Check the tie line and make corrections, if necessary.
4. Continue checking tie lines with Position / Find next command.

Position / Find next

Find next command is used to check tie lines with a mismatch larger than defined in the Find tie 
line dialog of Position / Find command. It requires that the Find command has been used to 
define the parameters for the search of bad tie lines. After that, you can check all tie lines that meet 
the search criteria by using the Find next command.

Check tie lines that meet specific search criteria:

1. Define the parameters for the tie line search with Position / Find command.
2. Check the first selected tie line and make corrections, if necessary.
3. Select Find next command from the Position pulldown menu.

The next tie line position with a mismatch larger than the defined threshold is selected in the 
list.

4. Continue with step 3 until the end of the tie line list is reached.

Setting: Effect:

Find by

Mismatch values as search criteria:
• Elevation mismatch - in design file master units.
• Xy mismatch - in design file master units.
• 3D mismatch - in design file master units.
• Angle mismatch - degree off from average.
• Wall angle - degree off from vertical.

Mismatch > Threshold value for searching bad tie lines.
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Position / Show scanner

Show scanner command can be used to check the scanner position when the system captured the 
data at a selected tie line location. This is useful, for example for determining whether a tie line is 
placed at a short or long distance from a scanner.

To show the scanner position:

1. Select a tie line position in the tie lines list.
2. Select Show scanner command from the Position pulldown menu.
3. Move the mouse pointer inside a MicroStation view.

A line is displayed between the selected tie line location and the scanner position.

4. Enter a data click in order to draw the line into the design file.

Position / Thin by travel distance

Thin by travel distance command removes tie line observations that are very close to each other. 
The distance between tie lines is measured as travel distance along a trajectory.

To thin tie lines based on travel distance:

1. Select Thin by travel distance command from the Position pulldown menu.

This opens the Thin by travel distance dialog:

2. Define the minimum distance allowed between tie lines in the Spacing field.
3. Click OK.

This removes tie line observations that are closer to each other than the given distance. An 
information dialog shows the number of deleted tie lines and tie line positions.
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Position / Filter bad

Filter bad command removes bad tie line observations automatically. This helps to reduce the 
manual effort for checking bad tie lines after the automatic tie line search.

The routine first runs the Find tie line fluctuations process on the tie lines using the given value 
for smoothing and solving the selected parameters. Then, it removes tie line observations with the 
largest residual mismatches. These two processes are repeated until there are no mismatch 
distances in tie line observations bigger than the given filter limit.

The filter limit should be defined in a way that valuable tie lines are not removed. It must not be 
set to a too small value, especially if heading, roll, and/or pitch corrections have to be solved.

To filter bad tie lines automatically:

1. Select Filter bad command from the Position pulldown menu.

This opens the Filter bad dialog:

2. Define settings and click OK.

This starts the filtering process. An information dialog shows the number of deleted tie lines 
and tie line positions after the process has finished. Depending on the amount of tie lines, the 
process may take some time.

Setting: Effect:

Filter limit Maximum allowed mismatch distance in tie line observations. This 
acts as a threshold for stopping the filtering process.

Keep all manual 
positions

If on, manually placed tie lines are not effected by the filtering 
process.

Max rate

Determines how fast the correction curve changes can be in the 
Find fluctuations process. A smaller factor results in a smoother 
curve. Values can range between 0.1 and 10.0, the default value is 
2.0.

Solve Xy Solves for a fluctuating xy correction.
Solve Z Solves for a fluctuating z correction.
Solve heading Solves for a fluctuating heading correction.
Solve roll Solves for a fluctuating roll correction.
Solve pitch Solves for a fluctuating pitch correction.
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Tools pulldown menu
The Tools pulldown menu contains commands for transforming tie lines and for drawing tie lines 
into the design file.

To: Choose menu command:
Transform tie lines Tools / Transform tie lines
Draw tie lines into the design file Tools / Draw observations
Create a list of locations without tie lines Tools / Report gaps
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Tools / Transform tie lines

Transform tie lines command is used to transform the coordinates of tie lines. The transformation 
must be defined in Coordinate transformations category in the TerraScan Settings.

To transform tie lines:

1. Select Transform tie lines command from the Tools pulldown menu.

This opens the Transform tie lines dialog:

2. Define settings and click OK.

This transforms the tie lines to the new projection system. You may save the transformed tie 
lines into a new file.

Setting: Effect:

Apply to

Data to transform:
• Known coordinates - transforms known point coordinate 

values (= values given by some other survey method).
• Laser positions - transforms observation coordinate values (= 

values extracted from laser data).
• Both - transforms known coordinates and laser positions.

Transformation
Name of the transformation to be applied. The name is defined 
Coordinate transformations category in the TerraScan 
Settings.
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Tools / Draw observations

Draw observations command draws tie line observations into the design file. The observations 
are drawn as point or line elements using the active level and symbology settings in MicroStation.

To draw tie line observations:

1. Select Draw observations command from the Tools pulldown menu.

This opens the Draw observations dialog:

2. Define settings and click OK.

This draws the tie line observations into the design file.

Setting: Effect:

Type Tie line type to be drawn: Any or one of the tie line types available 
in TerraMatch.

Only line If on, only tie lines of the given flight line number are drawn.
Only scanner If on, only tie lines of the given scanner number are drawn.
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Tools / Report gaps

Report gaps command creates a list of locations where there are no tie lines for given types of 
corrections.

The gaps found in active tie lines are displayed in a dialog. The user controls of the dialog let you 
sort the list of gaps in different ways, show the location of a gap, and rebuild the list after changes 
have been made to the tie lines.

To create a report of gaps between tie lines:

1. Select Report gaps command from the Tools pulldown menu.

This opens the Report gaps dialog:

2. Define settings and click OK.

This opens another Report gaps dialog which shows the list of gaps:

The list contains the chain (trajectory) number, the position of the gap along the chain, and the 
length of the gap.

You can use the options in the Sort by list to sort the list:

• Chain and position - primarily by the chain number, secondarily by increasing positions 

Setting: Effect:

Gap type

Determines which locations are defined as gaps:
• Xy - places with no tie lines for XY correction.
• Xy longitudinal - places with no tie lines for XY correction 

along the travel direction.
• Xy perpendicular - places with no tie lines for XY correction 

perpendicular to the travel direction.
• Z - places with no tie lines for Z correction.

Gap length Maximum allowed distance between tie lines. If the distance is 
bigger, it is reported as a gap.
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along the chain.
• Chain and length - primarily by the chain number, secondarily by decreasing lengths of the 

gaps.
• Length - by decreasing lengths of the gaps.

Show location - highlights the location of a gap. Select a row in the list and click on the button. 
Move the mouse pointer inside a MicroStation view. This highlights the selected gap by drawing 
a temporary dashed line. Place a data click in order to center the view at the gap’s center point.

Rebuild list - recomputes gaps after tie lines have been changed, for example, after new tie lines 
were added.
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View pulldown menu
The View pulldown menu contains commands for defining the settings for tie lines and for saving 
the view setup as default.

View / Settings

Settings command opens the Tie line Settings dialog. It is the same dialog as opened by the 
Define Tie Lines tool. 

To: Choose menu command:
Change the settings for tie line placement View / Settings
Save the view setup as default View / Display mode
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View / Display mode

Display mode command lets you define how tie lines are drawn in different MicroStation views. 
For each MicroStation view, you can select the coloring method, line weight, and limit the display 
of tie lines to certain criteria.

To set the display of tie lines:

1. Select Display mode command from the View pulldown menu.

This opens the Tie line display mode dialog:

2. Define settings and click Apply.

This applies the settings to the selected view. You can continue with the definition of settings 
for another view.

Setting: Effect:

View Number of the MicroStation view for which the settings are 
applied. The list contains view numbers 1-8.

Color by

Determines the coloring method:
• Do not draw - no tie lines are draw.
• Line - tie lines are colored by line number.
• Scanner - tie lines are colored by scanner number. This makes 

only sence if tie lines are collected separately for different 
scanners.

Weight Line weight for drawing tie lines. The list contains the line weights 
of MicroStation.

Only type

If on, only tie lines of the given type are drawn:
• Any known - tie lines of any “known” tie line type, such as 

Known xyz, Known xy, Known z, Known line.
• Any common - tie lines of any tie line type that is not “known”.
• <type> - tie lines of the selected type.

Only dimension

If on, only tie lines of the given dimension are drawn:
• Xyz - tie lines that provide full 3D (XYZ) control.
• Xy - tie lines that provide horizontal (XY( control.
• Z - tie lines that provide vertical (Z) control.

Only line
If on, only tie lines of the given line number(s) are drawn. You can 
define several line numbers by using minus and comma, for 
example, 1-5,7,10.
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Use the Pick visible line button to identify a trajectory line by a 
data click. The number of the line closest to the data click is used 
in the Only line field.

Only scanner
If on, only tie lines of the given scanner number(s) are drawn. You 
can define several scanner numbers by using minus and comma, 
for example, 1-3,5.

Only mismatch
If on, only tie lines within the given mismatch value range are 
drawn. Define the minimum and maximum mismatch value for 
drawing tie lines in the text fields.

Only slope

If on, only tie lines with the given slope value range are drawn. 
Define the minimum and maximum slope value for drawing tie 
lines in the text fields. 0.0 refers to horizontal, 90.0 to vertical 
direction. Tie points are not drawn if this option is on.

Setting: Effect:
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8 TerraMatch tools

Match tool box
The tools in the TerraMatch tool box are used to define user settings, to perform matching of 
laser data and to access online help.

To: Use:

Change user settings Settings

Define coordinate range and resolution Define Coordinate Setup

Find correction values for laser data Find Match

Apply known correction values Apply Correction

Correct fluctuating elevation differences Find Fluctuations

Match forward/backward measurements of 
elliptical scans Match Forward/Backward

Find range corrections caused by high intensity 
measurements Find Range Corrections

Find intensity corrections based on the distance 
from the scanner Find Intensity Correction

Measure how well strips match Measure Match

View information about TerraMatch About TerraMatch

View online help Help on TerraMatch



Page 57
8 TerraMatch tools

Settings

Settings tool lets you change a number of settings controlling the way how TerraMatch works. 
Selecting this tool opens the TerraMatch Settings dialog:

Settings are grouped into logical categories. If a category in the list is selected the appropriate 
controls are displayed to the right of the category list.

The settings are saved into the TerraMatch settings file in the installation directory when the 
Settings dialog is closed.

Default trajectory accuracy category
Default trajectory accuracy category defines estimates for the accuracy of trajectory positions. 
They are used for smoothing the correction curve in Find Tie Line Fluctuations if no other 
accuracy estimate values for trajectory positions are available.

The default values are recommended estimates for mobile data collected along rural roads. Larger 
values might provide better estimates for data collected inside urban areas.

Iteration convergence category
Iteration convergence category determines the stage at which the iterations in finding match 
tools stop. The iteration stops when the improvements are smaller than these threshold values or 
when the match no longer improves.

You may use bigger values if you want to stop the iteration sooner and just find an indication for 
the type of error in the data set. You should use small values when you want to find the exact 
correction parameters.

Operation category
Operation category defines the maximum number of threads that are used by TerraMatch 
processes. This effects some of the processes in TerraMatch which can run on several threads.

Setting: Effect:
Easting Easting convergence (m) - typically between 0.001 and 0.10.
Northing Northing convergence (m) - typically between 0.001 and 0.10.
Elevation Elevation convergence (m) - typically between 0.001 and 0.10.
Heading Heading convergence (deg) - typically between 0.0001 and 0.10.
Roll Roll convergence (deg) - typically between 0.0001 and 0.010.
Pitch Pitch convergence (deg) - typically between 0.0001 and 0.010.
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Signal markers category
Signal markers category lets you define signal markers which can be used for automatic tie line 
placement. Signal markers are bright paintings on dark ground surfaces, e.g. on a road surface, at 
the location of a control measurement. The signal marker can be identified in the intensity values 
of a dense laser point cloud. This enables the automatic placement of known xyz or known xy tie 
points.

The signal marker has to be drawn into a MicroStation design file before it can be defined in 
TerraMatch. It is advantageous to use an empty design file for the drawing and to place the signal 
marker in a way that the point of measurement corresponds to the design file origin. The drawing 
must include a larger rectangle that represents the dark background and the shape of the bright 
painting. An example is illustrated in the figures below.

To define a signal marker:

1. Create a drawing of the signal marker in a MicroStation design file.
2. Select the drawing.
3. Open Signal markers category from TerraMatch Settings.
4. Click Add in the Settings dialog
5. Define the origin of the signal marker drawing by either snapping to the origin (= point of 

measurement on the signal marker location) or by typing the key-in command:
xyz = 0,0,0

where 0,0,0 are the origin coordinates of the drawing.

Signal marker painting on a tram 
track

Signal marker drawing in 
MicroStation

Signal marker definition in 
TerraMatch
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This opens the Signal marker dialog:

6. Type a name for the signal marker and select a flipping method if required.
7. Click OK.

This adds the new signal marker to the list.

A signal marker’s name or flipping method can be modified by selecting the marker and clicking 
the Edit button in the Settings dialog. It can be deleted using the Delete button.

Standard deviations category
Standard deviations category specifies the assumed accuracy of orientation parameters. These 
settings help the algorithm to avoid singularity and to better translate observed mismatches into 
corrections.

Target objects category
Target objects category lets you define target objects for adjusting the position of mobile laser 
scanning data. Target objects are objects with a known three dimensional shape placed at a control 
point location.

To define a target object:

1. Open Target objects category from TerraMatch Settings.
2. Click Add in the Settings dialog.

Setting: Effect:
Easting Easting (m) - typically between 0.020 and 0.250.
Northing Northing (m) - typically between 0.020 and 0.250.
Elevation Elevation (m) - typically between 0.020 and 0.250.
Heading Heading (deg) - typically between 0.010 and 0.200.
Roll Roll (deg) - typically between 0.010 and 0.200.
Pitch Pitch (deg) - typically between 0.010 and 0.200.
Known points Known points (m) - typically between 0.005 and 0.05.
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This opens the Target object dialog:

3. Enter settings and click OK.

Setting: Effect:
Name Name of the target object.
Type Type or shape of the target object.
Radius Radius of a target object of type Ball.
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Define Coordinate Setup

Define Coordinate Setup tool sets up the coordinate system that TerraMatch uses for laser points. 
It determines the coordinate range inside which all points must be located and the resolution to 
which coordinate values are rounded. The coordinate setup is stored into the active design file and 
is used by TerraScan, TerraPhoto, TerraModeler, and TerraMatch.

TerraMatch uses signed 32 bit integer values for storing coordinates of laser points. This has the 
advantage of using only 12 bytes of memory for the coordinate information of each point. You can 
control how accurately laser point coordinate values are stored by defining how big each integer 
step is.

If, for example, one integer step is equal to one millimeter, all coordinate values are rounded to 
the closest millimeter. At the same time it would impose a limitation on how far apart points can 
be or how big the coordinate ranges are. Millimeter steps produce a coordinate cube which has a 
size of 232 millimeters or 4294967.296 meters. If the origin of the coordinate system is at [0.0, 0.0, 
0.0], the coordinate ranges are limited to values between -2147483 and +2147483. If necessary, 
you can fit the coordinate ranges to your data by modifying the Easting and Northing coordinates 
of the coordinate system origin.

If one integer step is equal to one centimeter, the coordinate values can range from -21 million to 
+21 million which is large enough for most coordinate systems.

To define a coordinate setup:

1. Select the Define Coordinate Setup tool.

This opens the Define Coordinate Setup dialog:

2. Define settings and click OK.

This modifies the coordinate system used by all Terra Applications in the active design file.

MicroStation SE and MicroStation J
Each design file contains a definition of a 32 bit integer coordinate system which MicroStation 
uses internally for vector elements. All applications share the same coordinate setup with 
MicroStation. When you change the coordinate setup with Define Coordinate Setup, it changes 
the design file coordinate system.

Since Terra Applications version 009.00x these MicroStation versions are no longer supported.
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MicroStation V8
MicroStation V8 uses 64 bit values for storing vector elements. TerraMatch uses a coordinate 
setup which is separate from the design file coordinate system. The application uses a default 
coordinate setup of 100 integer steps for each master unit. You can use Define Coordinate Setup 
tool to change the coordinate setup which the application stores in the design file but it does not 
affect MicroStation itself or the vector elements.
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Find Match

Find Match tool analyzes the mismatch in laser data and solves for correction parameters. The tool 
utilizes the surface-to-surface matching method described in Find match vs. Tie Lines on page 
15.

You can run Find Match either on points currently loaded into TerraScan’s memory or on a project 
definition. When running on a project, TerraMatch automatically scans thru all project blocks 
during one iteration round.

Pre-processing steps
Before you run Find Match, you must have performed a number of pre-processing steps which 
can be outlined as follows:

• Import trajectories into TerraScan.
• Split any trajectories which overlap themselves.
• Import time-stamped laser points into TerraScan.
• Make sure that strip numbering of laser points matches trajectory numbers.
• Classify low points.
• Classify ground separately for each strip.
• (Optional) Classify ground to another class in places which are best suited for comparison.
• (Optional) Classify buildings.
• (Optional) Smoothen ground surface if most of it is asphalt or some other hard surface.

Point classes for surface comparison
You can select the classes which to use in surface-to-surface comparison and how much weight 
to apply to each class. This makes it possible to manually classify locations which have sloped 
surfaces and to apply a higher weight value to those classes.

You may choose from the following strategies:

• Use ground points only and use High weight value for ground.
• Use good surfaces only. Classify suitable locations manually to Building class or Sloped 

ground class. Use High weight value for the classes.
• Use both ground points and good surfaces. Classify suitable locations manually. Apply High 

weight value to those classes and Low or Medium weight to ground class.
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Running Find Match

General procedure for solving for correction parameters:

1. Select the Find Match tool.

This opens the Find match dialog:

2. Enter setting values and click OK.

The application runs through a number of iterations which may last anything from a few 
seconds to several hours depending on the size of the data set. When the iteration has 
converged, the Apply results dialog opens:
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3. View the report and optionally store it as a text file.
4. Save a corrections file by using the Save corrections command from the File pulldown 

menu. This enables the application of the corrections later using the Apply Correction tool. 
5. Click Cancel to close the dialog without applying the corrections directly.

OR

4. When using a project, you should set the directory into which the output files are written. 
When using loaded points, corrections are applied to the loaded points in memory.

5. Check all strips to which you want to apply the correction in the lower list box.
6. Click OK to apply the corrections directly.

Find match setting: Effect:
Use Points to use in comparison: Loaded points or Project points.

Laser project TerraScan project file which defines the blocks to use in 
comparison. Selectable only when Use is set to Project points.

Trajectory dir Directory containing TerraScan trajectory files.

Correct
Quality of trajectories to correct. This allows you to keep better 
quality trajectories as fixed and compute corrections for lower 
quality trajectories only.

Known points Optional text file containing known points.

Progress If set to Saving intermediate results, the software saves the 
solution values after each iteration.

Results Path to the file for saving intermediate results. This is only active 
when Progress is set to Save intermediate results.

Use classes Classes to use for comparison and weight factors to apply.
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It is a good idea to save the correction parameters into a separate file using Save corrections 
command from the Apply results dialog. This makes it easy to apply the corrections later on using 
Apply Correction tool.

Observe every How many points to make an observation with. Use 1 for small 
data sets and a bigger value (2-5) for large data sets.

Max triangle Maximum length of a triangle created for the surface-to-surface 
comparison.

Ignore limit

Limit value for differences between strips that the software tries to 
match. The values should be a bit higher than the largest mismatch 
between strips. Larger mismatches are treated as gross errors and 
therefore not included in the calculation.

Solve for

Type of solution to find:
• Whole data set - one value per selected correction to apply to 

the whole data set.
• Individual lines - separate correction values for each strip per 

selected correction. 
Easting shift Solves for a constant easting correction value.
Northing shift Solves for a constant northing correction value.
Z shift Solves for a constant elevation correction value.
Heading shift Solves for a constant heading correction value.
Roll shift Solves for a constant roll correction value.
Pitch shift Solves for a constant pitch correction value.

Mirror scale for whole Solves for a mirror scale factor. Always solved for the whole data 
set, no matter what type of solution is selected in the Solve for list.

Easting drift Solves for easting correction which changes linearly by time.
Northing drift Solves for northing correction which changes linearly by time.
Elevation drift Solves for elevation correction which changes linearly by time.
Heading drift Solves for heading correction which changes linearly by time.
Roll drift Solves for roll correction which changes linearly by time.
Pitch drift Solves for pitch correction which changes linearly by time.

Find match setting: Effect:
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Apply Correction

Apply Correction tool applies known correction values to a data set. You can type in the correction 
values manually or they can be loaded from a TerraMatch corrections file saved by the following 
tools:

• Find Match
• Find Fluctuations
• Match Forward/Backward
• Find Range Corrections
• Find Intensity Correction
• Find Tie Line Match
• Find Tie Line Fluctuations

The tool allows to apply corrections to several types of data, such as laser data, tie lines, 
trajectories, and image lists in TerraPhoto.

In the process of applying corrections, the software interpolates values between observation 
locations, such as tie lines, relative to the travel distance. This method is more accurate than 
interpolation relative to time, especially for ground-based mobile scanning data sets where stops 
may occur.

General procedure for applying corrections:

1. Select the Apply Correction tool.

This opens the Apply corrections dialog:

2. Define settings and click OK.

This opens subsequent dialogs where you can enter or verify the correction values to apply.

Setting: Effect:

Apply to

Data set to correct:
• Project points - all blocks referenced by a given project file.
• Loaded points - points loaded into TerraScan.
• Tie line file - tie lines in a file saved on a hard disk.
• Loaded tie lines - active tie lines in TerraMatch.
• Loaded image list - active image list in TerraPhoto.
• Trajectories - active trajectories in TerraScan.

Laser project TerraScan project file to apply corrections to. This is only active if 
Apply to is set to Project points.

Write to
Directory into which to write the modified block binary files or the 
modified trajectory files. This is only active if Apply to is set to 
Project points or Trajectories.

Trajectory dir Directory containing TerraScan trajectory files.
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Key-in command syntax for Apply correction:

apply=points/project/tiefile/tielines/images
trajdir=trajectory_folder
project=project_file
writedir=result_folder
corrections=correction file
run=0/1

Example:

apply=project trajdir=c:\data\trajectory_scan 
project=c:\data\laser02\tscan.prj writedir=c:\data\laser03 
corrections=c:\data\calib\fluct_xyz.tms run=0

Corrections

Source of correction values:
• Enter manually - corrections values are typed manually.
• Load from file - reads correction values from a TerraMatch 

corrections file.

File File containing correction values. This is only active if 
Corrections is set to Load from file.

Correct

Type of correction to apply:
• Whole data set - one value to apply to the whole data set.
• Individual lines - separate correction values for each strip.

This is only active if Corrections is set to Enter manually.

Setting: Effect:
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Find Fluctuations

Find Fluctuations tool compares short intervals of each strip against other overlapping strips. It 
computes elevation corrections for each strip based on a surface-to-surface comparison method. 
Each short time interval of a strip gets its own correction value. For the final correction file, the 
correction values can be averaged in order to get a smoother correction curve.

Find Fluctuations tool requires that laser points have time stamps and that the same pre-
processing steps have been applied for the laser data as for the Find Match tool. You have to 
classify ground in each strip separately before this tool can be used. It does not require that 
trajectories are loaded. It uses trajectory information only to determine the relative accuracies of 
different strips.

The tool can run on loaded points in TerraScan or on a TerraScan project.

General procedure for finding and applying fluctuating corrections:

1. Select Find Fluctuations tool.

This opens the Find fluctuations dialog:

2. Select settings and click OK.

Setting: Effect:
Solve Type of solution to find: Elevation.

Use Points to use in find fluctuations: Loaded points or Project 
points.

Laser project TerraScan project file which defines the blocks to use in 
comparison. Selectable only when Use is set to Project points.

Trajectory dir Directory containing TerraScan trajectory files.
Use classes Classes to use for comparison and weight factors to apply.
Interval Time interval used by the software to calculate a correction value.

Max triangle Maximum length of a triangle created for the surface-to-surface 
comparison.
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This opens the Fluctuations dialog:

The dialog shows the list of strips on the left and a graph of corrections for the selected strip 
on the right. The yellow bars in the graph represent the time intervals for which a correction 
value is calculated. The correction value for a selected time interval is shown on top of the 
graph. 

3. Check the fluctuating corrections using the buttons and menu commands from the 
Fluctuations dialog. The options are described in Section Fluctuations dialog for surface 
matching.

4. Save a corrections file using the Save results command from the File pulldown menu. The 
correction file allows to apply corrections later to the laser data with the Apply Correction 
tool.

OR

5. Apply corrections directly using the Apply button in the Fluctuations dialog.

This opens the Apply fluctuation corrections dialog:

6. Define settings and click OK.

This applies the fluctuating corrections to the laser data.

Ignore limit

Limit value for differences between strips that the software tries to 
match. The values should be a bit higher than the largest mismatch 
between strips. Larger mismatches are treated as gross errors and 
therefore not included in the calculation.

Setting: Effect:
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Fluctuations dialog for surface matching

The Fluctuations dialog provides several buttons and menu commands for visualizing, analyzing 
and saving the fluctuating correction values.

Show location
Show location button is used to highlight the location of a time interval in a MicroStation view. 
The time interval must be selected in the Fluctuations dialog graph.

To show the location of a tie line observation:

1. Select a time interval in the Fluctuations dialog graph.
2. Click the Show location button.
3. Move the mouse pointer into a MicroStation view.

This highlights the selected time interval in the view.

4. Press the left mouse button to center the view at the location of the time interval.

Identify
Identify button is used to select the location of a time interval in the Fluctuations dialog graph. 
The location is identified with a mouse click in a MicroStation view.

To select a tie line observation in the Fluctuations dialog:

1. Click the Identify button.
2. Select a location in a MicroStation view.

This selects the time interval closest to the mouse click in the Fluctuations dialog graph.

Edit / Find big correction values
Find big correction values command selects locations with big correction values. It can find the 
largest value or values that are larger than a defined threshold.

To locate big correction values:

1. Select Find big correction values command from the Edit pulldown menu.

This opens the Find fluctuation dialog:

Setting: Effect:

Correction

Method of averaging the correction values:
• One step - no averaging applied.
• Average of 3 - three observations are averaged.
• Average of 5 - five observations are averaged.
• Average of 7 - seven observations are averaged.
• Average of line - the average value of a strip is used as a 

correction value.

Factor
Factor multiplied to the calculated correction values. A value of 
50% means that the original correction values are multiplied by 
0.5.

Max correction Maximum allowed correction that is applied to the laser data.



2. Select settings and click OK.

The time interval with the maximum correction value or the first value larger than the defined 
threshold is shown in the Fluctuations dialog and selected on the graph.

Edit / Find next
Find next command can be used after the Edit / Find big correction values command has been 
used with Find set to Large value and a threshold. The command selects the next time interval 
along the graph with a correction value larger than the defined threshold.

View / Display settings
Display settings command defines settings for the graph display in the Fluctuations dialog. This 
includes settings for the size of the yellow bars representing the time intervals and the maximum 
range of correction values. In addition, settings for displaying the correction curve and applying 
some averaging to the correction values are defined.

To define settings for the display of fluctuation corrections:

1. Select Display settings command from the View pulldown menu.

This opens the Display settings dialog:

2. Define settings and click OK.

This applies the new settings to the graph display.

Setting: Effect:

Step size Defines the display size of one time interval (width of the yellow 
bar) in the Fluctuations dialog graph.

Range max Maximum correction value range displayed in the Fluctuations 
dialog graph.

Display correction 
curve

If on, the correction curve is displayed as blue line in the 
Fluctuations dialog graph.
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When a correction file is saved from the Fluctuations dialog, the settings for a correction curve 
and for averaging correction values are used as defined in the Display settings dialog.

View / Statistics
Statistics command shows a dialog with some statistical values for the fluctuations per strip and 
for all strips. The statistics includes minimum, maximum, and average correction value, median, 
average magnitude and standard deviation.

You can save a text file or print the statistics using commands from the File pulldown menu in the 
Statistics dialog. The dialog size can be changed with commands from the View pulldown menu.

Correction

Method of averaging the correction values:
• One step - no averaging applied.
• Average of 3 - three observations are averaged.
• Average of 5 - five observations are averaged.
• Average of 7 - seven observations are averaged.
• Average of line - the average value of a strip is used as 

correction value.

Factor
Factor multiplied to the calculated correction values. A value of 
50% means that the original correction values are multiplied by 
0.5.

Max correction Maximum allowed correction that is applied to the laser data.

Setting: Effect:
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Match Forward/Backward

Match Forward/Backward tool can be used for matching flightlines from scanner systems which 
measure the same location twice in a single flight pass, e.g. by elliptical scan pattern.

The tool requires that surfaces are classified per flightline with forward and backward 
measurements in separate classes. It translates the differences between the forward and backward 
points into corrections of heading, pitch and/or fluctuating elevation corrections using a surface-
to-surface matching method.

The Match Forward/Backward tool can use loaded points in TerraScan as well as point files 
referenced by a TerraScan project. It needs TerraScan trajectories for finding a solution. It can 
solve for one misalignment angle or the elevation correction at a time.

Find Forward/Backward matching corrections:

1. Select the Match Forward/Backward tool.

This opens the Match Forward and Backward dialog:

2. Enter settings and click OK.

This opens the Fluctuations dialog. Proceed with applying corrections as described 
above for Find Fluctuations tool.

Setting: Effect:

Use
Data to use for comparison:
• Project points - all blocks referenced by a given project file.
• Loaded points - points loaded into TerraScan.

Laser project TerraScan project file to apply corrections to. This is only active if 
Apply to is set to Project points.

Trajectory dir Directory containing TerraScan trajectory files.

Solve Parameter for which a correction is solved: Elevation, Heading or 
Pitch.
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Match across flightlines
If on, an elevation correction is solved in a way the matches 
individual flightlines to each other as well. This is only active if 
Solve is set to Elevation.

Forward class Class that contains points on surfaces from forward scans per 
flightline.

Backward class Class that contains points on surfaces from backward scans per 
flightline.

Interval Time interval used by the software to calculate a correction value. 

Max triangle Maximum length of a triangle created for the surface-to-surface 
comparison.

Ignore limit

Limit value for differences between forward and backward 
surfaces that the software tries to match. The values should be a bit 
higher than the largest mismatch between forward and backward 
points. Larger mismatches are treated as gross errors and therefore 
not included in the calculation.

Setting: Effect:
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Find Range Corrections

Find Range Corrections tool solves range corrections for different intensity values. Very high 
intensity values may cause a wrong elevation value for the laser points which leads to local 
inaccuracies at such locations. Usually, points with high intensity values are a bit raised from the 
surrounding surface and from their correct elevation level. The system manufacturer provides a 
range correction file specific for the system. The Find Range Corrections tool can be used to 
adjust the values from this initial system-specific correction.

Finding range corrections requires laser data from a smoothly changing hard surface with different 
intensities. The points on the surface must be classified into a separate class. For airborne scanning 
data from the airport runways with strong white paint markings are good locations for collecting 
suitable data. For mobile scanning data a road or a parking space with a special calibration mat 
can be used.

The tool provides adjustment values for different intensities in a TerraMatch correction file. This 
correction file can then be used to apply the corrections to the laser data of a project. There is also 
an option for combining the adjustment found in TerraMatch with a the range correction values 
provided by the system manufacturer. This makes it possible to use the derived correction model 
for future data sets.

Find range correction:

1. Load the laser data into TerraScan from the area that is suitable for finding range 
corrections.

2. Select the Find Range Correction tool.

This opens the Find Range Correction dialog:

3. Define settings and click OK.

Setting: Effect:

Max intensity
Maximum intensity value for which range corrections should be 
found. Common values are 255 for 8 bit intensity, 4095 for 12 bit 
intensity and 65535 for 16 bit intensity data.

Use best
Defines what points the software uses for finding range 
corrections. The software uses the given percentage of points with 
the highest local intensity variation.

Ignore limit Helps to avoid bad observations. The software ignores 
observations with a elevation difference bigger than this value.
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This opens the Range Correction Results dialog:

4. Define settings.

5. Save the TerraMatch range corrections using the Save corrections command from the File 
pulldown menu or use the Merge with system file command from the File pulldown menu 
in order to create a correction file that includes system-specific corrections.

6. Close the Range Correction Results dialog.
7. Apply the range corrections to laser data using the Apply Correction tool.

Trajectory dir Directory containing TerraScan trajectory files.
Use classes Classes to use for finding range corrections.

Setting: Effect:
Scanner Number of the scanner for which to apply range corrections.

View
Intensity value range for display:
• Whole range - whole range from 0 to Max intensity.
• Observed range - intensity range avaiable in the used points.

Smoothing Number of smoothing rounds to apply to the correction curve.

Fill ends

How to assign correcion values to very small or very large 
intensity values for which there are no observations:
• Approach zero - correction values linearly approach zero.
• Closest observation - uses correction value of the closest 

intensity value with an observation.

File / Save correction Saves a TerraMatch correction file for being used in the Apply 
Correction tool.

File / Merge with 
system file

Adds the corrections to another correction file provided by the 
system manufacturer and saves a TerraMatch correction file for 
being used in the Apply Correction tool.

Setting: Effect:
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Find Intensity Correction

Find Intensity Correction tool solves intensity corrections based on the range of a point from the 
scanner. This is useful for mobile laser data if the intensity values of points systematically increase 
with the point’s 3D distance from the scanner. 

Finding intensity corrections requires laser data from overlapping strips or scanners and preferable 
from a hard surface, such as a road surface. The points on the surface must be classified into a 
separate class. The correction is computed per scanner by comparing intensity values of one 
scanner with all other points within a given sample radius.

The tool provides correction values for range intervals in a TerraMatch correction file. This 
correction file can then be used to apply the corrections to the laser data of a project. There is also 
an option of smoothing the correction values.

Intensity correction should be done when strips have been matched but the overlap between strips 
is not yet cut off. It may help to improve the result of extracting vector elements for paint markings 
automatically or for generating intensity ortho images with TerraScan.

To find intensity correction:

1. Load laser data into TerraScan from an area that is suitable for finding intensity corrections.
2. Select the Find Intensity Correction tool.

This opens the Find Intensity Correction dialog:

3. Define settings and click OK.

Setting: Effect:

Minimum range Minimum 3D distance from the scanner used for computing the 
intensity correction values.

Maximum range Maximum 3D distance from the scanner used for computing the 
intensity correction values.

Range interval
Distance interval for computing correction values. One correction 
value is computed for each interval within Minimum range and 
Maximum range.
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This opens the Intensity Correction Results dialog:

4. Define settings.

5. Save the corrections using the Save corrections command from the File pulldown menu.
6. Close the Intensity Correction Results dialog.
7. Apply the range corrections to laser data using the Apply Correction tool.

Sampling radius
Distance around each point for comparing the point’s intensity 
value of one scanner with the average intensity values of all other 
points.

Trajectory dir Directory containing TerraScan trajectory files.
Use classes Classes to use for finding intensity corrections.

Setting: Effect:

Scanner Number of the scanner for which to apply intensity correction 
values.

Smoothing Number of smoothing rounds to apply to the correction curve.

Fill ends

How to assign correcion values to points for which there is no 
observation within the given Minimum and Maximum range:
• Approach zero - correction values linearly approach zero.
• Closest observation - uses correction value of the closest range 

interval with an observation.

File / Save correction Saves a TerraMatch correction file for being used in the Apply 
Correction tool.

Setting: Effect:
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Measure Match

Measure Match tool measures how well different strips match each other. It computes the 
elevation difference between surfaces from individual strips and a mean surface.

The report value can be used to determine if laser strips are matching each other better or worse 
compared to an earlier measurement. You can use this tool:

• Determine if strips match each other at normal level (comparing to earlier projects).
• Determine if a modification applied to laser data was an improvement (comparing before and 

after modification).

As the comparison is based on surfaces, you should normally perform ground classification on 
each strip individually before running this tool. You may also classify some other suitable surfaces 
such as building roofs from each strip.

Measure Match can use all the points from laser data files in a TerraScan project or loaded points.

To measure how well strips match:

1. Select the Measure Match tool.

This opens the Measure Match dialog:

2. Select rows in the list box for the classes to use in the comparison.
3. Define the other settings and click OK.

The application computes the average elevation differences between each strip and a mean 
surface.

Setting: Effect:

Use
Data to use for comparison:
• Project points - all blocks referenced by a given project file.
• Loaded points - points loaded into TerraScan.

Laser project TerraScan project file to apply corrections to. Selectable only 
when Apply to is set to Project points.

Max Triangle Maximum length of a triangle created for the surface-to-surface 
comparison.

Ignore limit
Limit value for differences between strips that the software uses 
for computing elevation differences. Larger mismatches are 
treated as gross errors and therefore not included in the calculation.
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The results are shown in the Measure report window:

Use classes Classes to use for computing elevation differences between 
individual strips and the mean surface.

Attribute: Meaning:
Average magnitude Mean value of absolute elevation difference values.
Flightline Number of the strip.
Points Amount of points for each strip.

Magnitude Absolute value of the elevation difference between a strip and the 
mean surface.

Dz Mean value of the elevation difference between a strip and the 
mean surface.

Setting: Effect:
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About TerraMatch

About TerraMatch tool opens a dialog which shows information about TerraMatch and about the 
license.

From this dialog you can open the License information dialog:

Use the Request license button to start the online registration for node-locked licenses.

More information about license registration is available on the Terrasolid web pages: 
www.terrasolid.com/registration.php.

Help on TerraMatch

Help on TerraMatch tool launches Acrobat Reader for accessing this Users’ Guide in PDF format. 
The PDF must be stored in the /DOCS folder of your Terra Software installation directory.

If you installed TerraModeler in the default directory C:\TERRA, the Users’ Guide must be stored 
in C:\TERRA\DOCS\TMODEL.PDF.

The PDF has hypertext links built in, so you can jump between topics by clicking on the topic 
names highlighted in green color.

Accessing the PDF also requires that you have the Acrobat Reader installed on your computer. 
The software looks for a file named ACRORD32.EXE. If the file can not be found, you are asked 
to locate the file on the hard disk manually.
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Tie line tool box
The tools in the Tie lines tool box are used to define tie line settings, to find a match solution and 
fluctuating corrections based on tie lines.

To: Use:

Define tie lines for matching Define Tie Lines

Find correction values using tie lines Find Tie Line Match

Find fluctuating corrections using tie lines Find Tie Line Fluctuations

Find rubbersheet correction matching data to 
control points Find Rubbersheet Fit
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Define Tie Lines

Define Tie Lines tool opens the dialog for tie line settings. It is the starting point for working with 
tie lines in TerraMatch. 

To start the tie line mode in TerraMatch:

1. Select Define Tie Lines tool.

This opens the Tie line settings dialog:

2. Define settings and click OK.

This opens the Tie line window and arranges the views for tie line work. See chapter 
Working with Tie Lines on page 26 for more information about how to work with tie lines.

Setting: Effect:

Full view Number of the MicroStation view for displaying a full top view of 
the data when the tie point mode is active.

Point radius Radius of a circle that is displayed in the Full view at the location 
of a tie line.

Entry view

Number of the MicroStation view for displaying laser data from all 
strips at a location of a horizontally-oriented tie line. The view is 
updated whenever a tie line position is selected in the Tie lines 
window.
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The settings for tie lines can be changed when the tie line mode is active using the View / Settings 
command from the View pulldown menu in the Tie line window.

Detail view

Number of the MicroStation view for displaying laser data from 
one strip at a location of a horizontally-oriented tie line. The view 
is updated whenever a tie line position is selected in the Tie lines 
window. In this view, tie lines can be placed manually.

Wall entry view

Number of the MicroStation view for displaying laser data from all 
strips at a location of a vertically-oriented tie line. The view is 
updated whenever a tie line position is selected in the Tie lines 
window.

Wall detail view

Number of the MicroStation view for displaying laser data from 
one strip at a location of a vertically-oriented tie line. The view is 
updated whenever a tie line position is selected in the Tie lines 
window. In this view, tie lines can be placed manually.

Top view length Length of top view to create for ground line and known line tie 
lines.

Helping lines Length of helping lines that are displayed in detail views when 
placing a tie line manually.

Arrange views 
automatically

If on, the MicroStation views are arranged on the screen according 
to the settings for entry and detail views.

Laser time gap Time difference between different strips at the same location.

Max error xy
Estimation of the maximum difference between strips in horizontal 
positioning. Only tie lines up to this distance are accepted in 
automatic tie line search.

Max error z
Estimation of the maximum difference between strips in elevation 
positioning. Only tie lines up to this distance are accepted in 
automatic tie line search.

Fit tolerance Estimation of the noise level in the data. It determines how tie lines 
are fitted to the data of one strip.

Ground classes Laser point classes for the automatic search of Section lines on flat 
ground and on surfaces.

Wall classes Laser point classes for the automatic search of Section lines on 
vertical walls.

Roof classes Laser point classes for the automatic search of Roof intersection 
lines.

Target classes
Laser point classes for the automatic search of targets. Targets can 
be defined in Target objects category of the TerraMatch 
Settings.

Separate scanners Of on, tie lines are placed for each scanner separately. This is used 
for scanner system calibration.

Line width Estimation of the width range of paint markings. This is used for 
placing Ground tie lines automatically.

Trajectory dir Directory where the TerraScan trajectory files are stored.

Setting: Effect:
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Find Tie Line Match

Find Tie Line Match tool analyzes the mismatch in the tie lines and searches correction values. 
The tool utilizes the feature-to-feature matching method described in Find match vs. Tie Lines 
on page 15.

In preparation of using this tool, you have to import trajectories into TerraScan and collect tie lines 
that are suited for solving the required parameters.

General procedure for solving and applying correction parameters:

1. Select the Find Tie Line Match tool.

This opens the Find Tie Line Match dialog:

2. Define settings and click OK.
3. If Correct is set to Selected sets, the Select sets to correct dialog opens. Select the 

group(s) or line(s) for which to calculate correction values and click OK.

The software calculates correction values for the selected parameters. It opens the Find Tie 
Line Match Results dialog. The dialog shows information about the correction values and 
the number of usable observations for each parameter.

Setting: Effect:

System Scanner system used for collecting the laser data: Airborne or 
Mobile.

Source
Source file for calculating the correction values:
• Active tie lines - tie lines in an open Tie line window are used.
• Tie line file - tie lines stored in a tie line file are used.

Tie lines Path to the tie line file that is used for calculating the correction 
values. This is only active when Source is set to Tie line file.

Trajectory dir Directory where the TerraScan trajectory files are stored.

Solve for

Type of solution to find:
• Whole data set - a solution for the whole data set is calculated.
• Line groups - a solution for strips of different groups is 

calculated. This requires that groups are defined for the 
TerraScan trajectories.

• Individual lines - a solution for each strip is calculated.
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4. Save a corrections file using the Save corrections command from the File pulldown menu 
in the Find Tie Line Match Results dialog. You can also save a text file and print the 
report by utilizing the corresponding commands from the File pulldown menu in the dialog.

5. Use the Apply Correction tool from the Match tool box to apply the corrections to the laser 
data, tie lines, or other files.

Lever arm corrections should actually not be solved by using tie lines. However, the functionality 
can be used to remove remaining mismatch in the data due to lever arm inaccuracies. Mainly, the 
options to solve lever arms with tie lines has been implemented in the software in order to calibrate 
data from several laser heads of one scanner.

Scanners

Defines how data from different scanners is used:
• Combined solution - a solution for all scanners is calculated.
• Solution per scanner - a solution for each individual scanner 

is calculated.

Correct

Defines how line groups or individual lines are corrected:
• All solution sets - a solution is calculated for being applied to 

all strips or groups.
• Selected sets - a solution only for selected strips or groups is 

calculated.
This is only active when Solve for is set to Line groups or 
Individual lines.

Easting shift Solves for a constant easting correction value. This is only active 
if System is set to Airborne.

Northing shift Solves for a constant northing correction value. This is only active 
if System is set to Airborne.

Z shift Solves for a constant elevation correction value. This is only active 
if System is set to Airborne.

Mirror scale Solves for a mirror scale factor. This is only active if System is set 
to Airborne.

Heading shift Solves for a constant heading correction value.
Roll shift Solves for a constant roll correction value.
Pitch shift Solves for a constant pitch correction value.

Lever X Solves for a constant lever arm correction in X (left - right) 
direction. This is only active if System is set to Mobile.

Lever Y Solves for a constant lever arm correction in Y (forward - 
backward) direction. This is only active if System is set to Mobile.

Lever Z Solves for a constant lever arm correction in Z (up - down) 
direction. This is only active if System is set to Mobile.

Setting: Effect:
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Find Tie Line Fluctuations

Find Tie Line Fluctuations tool compares short intervals of each strip against other overlapping 
strips. It computes corrections for different parameters based on tie lines. Each short time interval 
of each strip gets its own correction value. For the final correction file, the correction curve can 
be smoothed.

Find Fluctuations tool requires tie lines that are suitable for calculating fluctuating correction 
values for the different parameters. The tie lines are collected using commands from the 
TerraMatch Tie line window. Additionally, tie points collected in TerraPhoto based on images 
can be included in the calculation. The tie points in TerraPhoto must be of types Known depth or 
Depth tie points.

The smoothing of the correction curve involves the accuracy estimates for trajectory positions. 
Bigger corrections values are applied for positions where the accuracy estimate is worse. The Max 
rate factor determines, how fast the corrections curve changes can be. A small factor results in a 
smoother curve. This should be used if the tie lines are not so good and may contain outliers. A 
bigger factor results in a less smooth curve and the single tie line observations get more influence 
in the final solution. This should be used for good tie lines. The factor can range between 0.1 and 
10.0, its default value is 2.0.

If accuracy estimates for trajectory positions are not available, the software uses values defined in 
Default trajectory accuracy category of the TerraMatch Settings.

General procedure for finding and applying fluctuating corrections:

1. Select Find Tie Lines Fluctuations tool.

This opens the Find Tie Line Fluctuations dialog:

2. Define settings and click OK.

Setting: Effect:

Source
Source file for calculating the fluctuating corrections:
• Active tie lines - tie lines in an open Tie line window are used.
• Tie line file - tie lines stored in a tie line file are used.

Tie lines Path to the tie line file that is used for calculating the corrections. 
This is only active when Source is set to Tie line file.
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This opens the Fluctuations dialog:

The dialog shows the list of strips on the left and a graph of corrections for the selected strip 
on the right. The red bars in the graph represent the tie line observations from which a 
correction value is calculated. The correction value for a selected observation is shown on 
top of the graph. 

3. Check the fluctuating corrections using the buttons and commands from the Fluctuations 
dialog. The options are described in Section Fluctuations dialog for tie lines.

4. Save a corrections file using the Save corrections command from the File pulldown menu.
5. Apply the corrections to the laser data, tie lines, and other data types using the Apply 

Correction tool.

Image tie points

Determines whether tie points from TerraPhoto included in the 
calculation:
• Do not use - no tie points from TerraPhoto are used.
• Active tie points - known depth tie points are used if a tie point 

file is loaded in TerraPhoto.

Use

Defines what tie lines to use for calculating the corrections:
• All tie lines - use all tie lines.
• Known points only - use only tie lines of type Known xyz, 

Known xy, Known z and Known line.
Trajectory dir Directory where the TerraScan trajectory files are stored.

Correction

Determines how much the correction curve is smoothed:
• Free curve - no smoothing is applied. Each tie line observation 

fully effects the solution.
• Smooth curve - smoothing is applied. The amount of 

smoothing is determined by the Max rate factor and effected 
by the accuracy of trajectory positions.

Max rate

Determines how fast the corrections curve changes can be. A 
smaller factor results in a smoother curve. Values can range 
between 0.1 and 10.0, the default value is 2.0. This is only 
available if Correction is set to Smooth curve.

Solve Xy Solves for a fluctuating xy correction.
Solve Z Solves for a fluctuating z correction.
Solve heading Solves for a fluctuating heading correction.
Solve roll Solves for a fluctuating roll correction.
Solve pitch Solves for a fluctuating pitch correction.

Setting: Effect:
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Fluctuations dialog for tie lines

The Fluctuations dialog provides several buttons and menu commands for visualizing, analyzing 
and saving the fluctuating correction values.

Show location
Show location button is used to highlight the location of a tie line in a MicroStation view. The tie 
line must be selected in the Fluctuations dialog graph.

To show the location of a tie line observation:

1. Select a tie line observation in the Fluctuations dialog graph.
2. Click the Show location button.
3. Move the mouse pointer into a MicroStation view.

This highlights the selected tie line observation in the view.

4. Press the left mouse button to center the view at the location of the tie line observation.

Identify
Identify button is used to select the location of a tie line in the Fluctuations dialog graph. The tie 
line is identified with a mouse click in a MicroStation view.

To select a tie line observation in the Fluctuations dialog:

1. Click the Identify button.
2. Select a tie line location in a MicroStation view.

This selects the tie line observation in the Fluctuations dialog graph.

Select tie line
Select tie line button is used to select a tie line observation in the Tie lines window. The tie line 
observation must be selected in the Fluctuations dialog graph.

To select a tie line observation in the Tie line window:

1. Select a tie line observation in the Fluctuations dialog graph.
2. Click the Select tie line button.

This selects the tie line observation in the Tie line window.

File / Display settings
Display settings command defines settings for the graph display in the Fluctuations dialog. This 
includes settings for displaying correction vectors in MicroStation views and for the content 
shown in the graph display.

To define settings for the display of fluctuation corrections:

1. Select Display settings command from the File pulldown menu.

This opens the Display settings dialog:
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2. Define settings and click OK.

This applies the new settings to the graph display and the vectors shown in MicroStation 
views.

Setting: Effect:
Scale xy Scale factor for the display of correction vectors in xy direction.
Scale z Scale factor for the display of correction vectors in z direction.

Display all correction 
vectors

If on, correction vectors are displayed as lines in MicroStation 
view. The length of the line is the correction value at this location 
scaled by the value set for Scale xy and Scale z.

Level Level number in the design file on which the correction vectors are 
displayed.

Top view Number of the MicroStation view for displaying the correction 
vectors in a top view.

3D view Number of the MicroStation view for displaying the correction 
vectors in a 3D view.

Profile view Number of the MicroStation view for displaying the correction 
vectors in a profile view.

Draw Correction that is displayed in the Fluctuations dialog graph.

Range max Maximum correction value range displayed in the Fluctuations 
dialog graph.

Second Defines the display size of one second time interval in the 
Fluctuations dialog graph.
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Find Rubbersheet Fit

Find Rubbersheet fit tool can be used to match data to control points. The matching is done based 
on a triangulated correction model for XYZ, XY, or Z.

The tool requires tie lines that are suitable for computing the correction model. The tie lines are 
collected using commands from the TerraMatch Tie line window. Suitable tie line types are 
Known xyz, Known xy, or Known z.

In the tool settings you can define how averaging is applied between closeby observations. 
Further, the values for the outer corners of the correction model can be either derived from the 
closest correction value or set to zero. The following figure illustrates the computation of a 
rubbersheet correction model.

The tool can be used, for example, as a last adjustment step for aerial airborne laser data. After 
matching the data internally, the data set is matched to control points using the rubbersheet 
correction.

General procedure for finding and applying fluctuating corrections:

1. Select Find Rubbersheet Fit tool.

This opens the Find Rubbersheet Fit dialog:
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2. Define settings and click OK.

This opens the Find Rubbersheet Correction Results dialog:

The dialog shows the report of the correction model computation. Starting and final average 
mismatch values indicate the level of improvement that can be achieved by applying the 
correction model. Further, list of all correction points of the model is shown.

3. (Optional) You may draw the correction vectors into the design file by using the command 
from the Draw pulldown menu. The commands open the Draw Correction Vectors dialog 
which lets you define a scale factor for drawing the correction vectors.

4. Save a corrections file using the Save corrections command from the File pulldown menu.

You may also save the report as a text file or print it directly by using the corresponding 
commands from the File pulldown menu.

5. Apply the corrections to the laser data using the Apply Correction tool.

Setting: Effect:

Source
Source file for calculating the fluctuating corrections:
• Active tie lines - tie lines in an open Tie line window are used.
• Tie line file - tie lines stored in a tie line file are used.

Tie lines Path to the tie line file that is used for calculating the corrections. 
This is only active when Source is set to Tie line file.

Trajectory dir Directory where the TerraScan trajectory files are stored.
Solve Defines what correction values are computed: Xyz, Xy, or Z.

Expand model Distance by which the correction model is expanded from the 
outest observation location to the outside.

Expand using

Determines how the values for the outside corners of the correction 
model are derived:
• Zero correction - the correction value is set to 0.0.
• Closest correction - the correction value is equal to the closest 

computed correction value.

Max count Maximum amount of observations that are averaged if they are 
located closeby.

Max distance Maximum distance between observations that are averaged.
Merge final correction 
points

If on, the final correction points are merged into one correction 
value according to the averaging settings.
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Additional Information
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9 Installation Directories
TerraMatch shares the same directory structure with all Terra Applications.  It is recommended 
that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when TerraMatch has been installed in path 
C:\TERRA.

c:\terra directory where TerraMatch is installed

config for configuration files

 tmatch.cfg defines environment variables

docs for documentation and online help

 tmatch.pdf documentation in PDF format

license for user license files

 tmatch.lic user license

ma for application files

 tmatch.ma application

 tmatch.dll library

 tmatchsb.dll library

tmatch for user preferences and settings
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10 Configuration Variables
MicroStation is able to locate TerraMatch with the help of configuration variables. When you 
install TerraMatch, the installation program creates a configuration file TERRA.CFG which 
defines the required environment variables. This file is placed in MicroStation's CONFIG\APPL 
subdirectory.

For example, C:\...\MICROSTATION\CONFIG\APPL\TERRA.CFG may contain:

#-------------------------------------------------------
#
#  TERRA.CFG - Configuration for Terra Applications
#
#-------------------------------------------------------

TERRADIR=c:/terra/
TERRACFG=$(TERRADIR)config/

MS_MDLAPPS < $(TERRADIR)ma/
MS_HELPPATH < $(TERRADIR)docs/

%if exists ($(TERRACFG)*.cfg)
%   include $(TERRACFG)*.cfg
%endif

This configuration file includes the application-specific configuration files in 
C:\TERRA\CONFIG directory. TerraMatch's configuration file TMATCH.CFG may contain:

#--------------------------------------------------------------
#
#  TMATCH.CFG - TerraMatch Configuration File
#
#--------------------------------------------------------------

#    Directory for storing the user license file (TMATCH.LIC)

TMATCH_LICENSE=$(TERRADIR)license/

#    Directory for user preferences (TMATCH.UPF)

TMATCH_PREF=$(TERRADIR)tmatch/

#    Directory for application settings (TMATCH.INF)

TMATCH_SET=$(TERRADIR)tmatch/

In a default configuration, MicroStation automatically includes these settings as configuration 
variables. You can use MicroStation's Configuration command from Workspace menu to check 
the values for these variables. In case these variables have not been defined correctly, you should 
define them manually.
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